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Introduction 

When communities include forests and trees outside forests (or non-forest canopy) in their greenhouse 

gas inventories (GHGI), they need to calculate the average annual change (gain and loss) in forest and 

non-forest canopy over their inventory cycle, as well as how much forest and non-forest tree canopy is 

unchanged. That constitutes the activity data for trees/forests in their GHG inventories. This guide 

explains how to calculate changes in non-forest canopy between two years using a website called i-Tree 

Canopy that allows you to interpret imagery under randomly placed points outside forests within your 

community boundaries. It can be used by communities inside the US that are following the US 

Community Protocol Appendix J (ICLEI 2019) or communities outside the US that are following the 

Global Protocol for Community-Scale Greenhouse Gas Inventories (GPC) Supplemental Guidance for 

Forests and Trees (WRI/ICLEI/C40 2022). Further information on community GHGIs and trees outside 

forests can be found in those documents. It is recommended but not required that users of this guide be 

familiar with Appendix J (USA) and/or the GPC supplemental guidance (all other countries), more for the 

context and inventory overviews they provide than for any specific details about these methods. 

 

A note about alternative approaches to estimating trees outside forests not covered here 

Before going into the i-Tree Canopy methods described in this document, it is important to note that i-

Tree Canopy is not the only way that communities can estimate GHG emissions and removals by non-

forest canopy. However, it is often the most accessible method as it requires minimal GIS expertise and 

resources to implement. If communities have high-resolution canopy maps from LiDAR or aerial imagery 

from multiple years obtained using the same methods, they can use that instead to identify trees 

outside forests and change in canopy. However, most communities do not have such LiDAR data. This 

guide assumes that communities are going to use i-Tree Canopy for estimating activity data for their 

trees outside forests.  

Communities in the US have another option for estimating GHG emissions and removals by non-forest 

canopy as well: the US National Land Cover Dataset (NLCD) tree canopy maps. However, the NLCD tree 

canopy maps are currently only available for 2011 and 2016, making them not useful for communities 

that are conducting inventories not close to those years. For US communities whose inventory cycle 

does align with the available dates for NLCD tree canopy maps, NLCD may still not be a great option 

because it is 30-m resolution, which is too coarse to detect many isolated, non-forest trees. Based on 

the experience of some pilot communities, it appears that using NLCD tree canopy data may 

underestimate non-forest canopy in communities by 50% or more. In highly urbanized communities with 

less forest, NLCD is likely to underestimate non-forest canopy by an even higher percentage. 

Underestimating non-forest canopy will omit the emissions and removals associated with trees outside 

forests from your inventory and make your inventory less complete. Whether NLCD will capture enough 
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non-forest canopy in your community really depends on how much of your forest canopy is outside 

forests and needs to be explored before deciding what approach to take. 

Again for US communities only, as a simple first estimate, the ICLEI LEARN tool 

(http://www.icleiusa.org/learn/) allows users to calculate changes (loss and gain) in tree canopy outside 

forests. As of mid-2022, communities in the Chesapeake Bay watershed that use the LEARN tool will 

have the option to use high-resolution watershed-wide data that picks up small changes in non-forest 

canopy for their activity data. For the rest of the US, the LEARN tool uses NLCD canopy data, which is 

coarse resolution and has a very limited selection for years. Refer to the LEARN tool website and 

documentation for the latest guidance on the tool.  

 

Overview of this guide 

While some communities may have the necessary LiDAR data or be able to use some other approach for 

estimating change in non-forest canopy, for many communities i-Tree Canopy has a good balance of 

accuracy, accessibility, customizability, and effort. This tutorial covers how to calculate the change in 

non-forest canopy using i-Tree Canopy. This will constitute the activity data for your inventory’s trees 

outside of forests and can be multiplied by the appropriate emission and removal factors to get 

emissions and removals for trees outside of forests. The analysis essentially involves determining 

whether randomly placed points within your area of interest have trees there using aerial imagery; each 

point is assigned “tree” or “non-tree”. 

As the USCP Appendix J and the GPC Supplemental Guidance for Forests and Trees describe, a GHG 

inventory for trees outside forests requires data on non-forest tree canopy in at least two years so that 

change (area lost, gained, and maintained) can be estimated. One year of non-forest canopy is not 

enough for a GHG inventory because it does not represent changes in tree canopy over time. Thus, you 

must complete Parts A or B (canopy extent in individual years) before using Part C (i.e. calculate non-

forest canopy in two years before calculating the change in non-forest canopy). The activity data you get 

at the end of Part C can be multiplied by the emission and removal factors you are using in your 

inventory to estimate the gross emissions and removals for trees outside forests during the time period 

you are working with. For US communities, those emission and removal factors can be found in the 

LEARN tool; for non-US communities, those emission and removal factors need to be obtained 

elsewhere (see GPC supplement for guidance).  

i-Tree Canopy is a free web tool that is part of the i-Tree suite of tools. i-Tree Canopy allows users to 

estimate tree canopy area in areas of interest at a particular time by interpreting aerial imagery.  

● Part A of the tutorial will show you how to use i-Tree Canopy to calculate canopy cover outside 

forests for the current year or very recent years using recent imagery, as opposed to imagery 

from a specific year in the past. Using this part of this guide is only necessary if one of your years 

for non-forest canopy change is the current non-forest canopy (e.g. 2018 vs. 2022).  

● Part B shows how to calculate non-forest canopy in one or more past years. It uses historical 

imagery found in Google Earth. For communities that are calculating forest fluxes over two years 

in the past (e.g., 2010 to 2013), the non-forest canopy cover in the current year is not strictly 
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relevant, though current non-forest canopy may still be of interest for comparison or to 

measure community progress.  

● Part C covers how to calculate change in non-forest canopy between two years using the data 

from Parts A and/or B. Those two years could be one year in the past and the present year (e.g., 

2016 vs. current imagery) or two years in the past (e.g., 2010 vs. 2013). The output of Part C is 

the non-forest canopy activity data (total non-forest canopy loss and non-forest canopy gained 

and maintained) to which your non-forest canopy emission and removal factors are applied.   

If you want to stratify your non-forest canopy GHG inventory by different areas or land uses (for 

example, settlement vs. grassland, public vs. private land), you need to decide this before beginning the 

i-Tree assessment. You will have to repeat this analysis for each inventory stratum separately. You will 

need to have shapefiles for each land use by which you want to stratify and then do Parts A and/or B 

and Part C on them individually. Some land classes may not need much analysis or many points, while 

others may need a full evaluation. Your community will have to experiment with that. 

Because i-Tree Canopy uses manual interpretation of points overlaid on satellite imagery, this analysis 

can be quite time-consuming, especially if multiple strata or inventory cycles are included. However, 

once someone has done one i-Tree analysis, subsequent ones should go more quickly. Many people who 

have done this analysis say they have simultaneously listened to the radio or podcasts once they are 

comfortable with it and the time goes by quickly. 

NOTE: This tutorial assumes use of ArcMap 10.x. I do not know how well this will work in ArcGIS Pro. It 

also requires a Spatial Analyst license for some steps. This guide was developed and tested during 

November 2020. Subsequent changes to i-Tree Canopy may not be reflected in this guide. 

 

Contact information (feedback welcome): 

David Gibbs, World Resources Institute, david.gibbs@wri.org 

Nancy Harris, World Resources Institute, nancy.harris@wri.org  

Erin Glen, World Resources Institute, erin.glen@wri.org  

Tom Herrod, ICLEI, tom.herrod@iclei.org 

Calyn Hart, ICLEI, calyn.hart@iclei.org   
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Part A: Using i-Tree Canopy to get non-forest canopy cover in current year 

This section describes how to calculate non-forest canopy area in the current or very recent year. It uses 

the imagery available in i-Tree Canopy, which seems to be some variant of what is most recently 

available in Google Earth. Only use this part of the guide if you want to calculate current non-forest 

canopy, either as one end of your inventory or because your community is interested in it in its own 

right. Proceed to Part B for calculation of non-forest canopy in past years using i-Tree Canopy.  

1. To analyze non-forest canopy, we first need to delineate non-forested areas within the 

inventory area. Theoretically, this could be done in several ways depending on the forest data 

your community has available, but this tutorial will use NLCD because that is universally 

available. First, we need to create a shapefile of non-forest area to upload to i-Tree Canopy. i-

Tree has a limit to how large the uploaded shapefiles can be, so this method may not work for 

large counties with complex forest shapes (which will result in larger non-forest shapefiles). 

According to i-Tree technical support, the upload limit is 2.0 MB, but I have successfully 

uploaded a shapefile that was 3.0 MB (and could not upload a 5.5 MB file), so I don’t know the 

actual limit. To do this, clip the NLCD 2016 raster to your inventory area using the Clip (Data 

Management) tool in ArcMap. (This tool clips rasters.) Make sure to select the “Use Input 

Features for Clipping Geometry” box to clip NLCD exactly to your inventory boundary. 

 
2. From NLCD clipped to your inventory boundary, create a raster of non-forest NLCD pixels using 

the “Con” tool within your inventory area. (This tool requires the Spatial Analyst license.) The 

forest classes are Deciduous Forest (41), Evergreen Forest (42), Mixed Forest (43), and Woody 

Wetlands (90). If using NLCD, put “"Value" NOT IN (41, 42, 43, 90)” in the “Expression” input. 

NOTE: Although we are estimating current non-forest canopy, the latest NLCD map is 2016, so 

we have to use that for delineating non-forest area. Thus, there is a temporal mismatch 



 

between the non-forest boundary (2016) and the non-forest canopy (recent imagery, 

approximately 2020 at the time of writing). 

 
 

3. Add a new “short integer” field to the non-forest NLCD land cover raster attribute table with any 

name (here, “dissolve”). This should create a field that has the same value for every raster value 

(i.e. 0). Then, use the “Raster to Polygon” tool to convert the non-forest raster to a shapefile, 

with your new field being in the “Field” argument. Leave “Simplify polygons” unchecked and 

check “Create multipart features”. The resulting shapefile should be one feature with multiple 

parts. Also, calculate the area of the non-forest shapefile using the “Add Geometry Attributes” 

tool (“AREA” or “AREA_GEODESIC” are okay). I recommend calculating area in hectares because 

the emission and removal factors are in tons of CO2 per hectare. 

  



 

 

4. i-Tree Canopy requires that the shapefile be unprojected in WGS84 coordinate system 

(EPSG:4326). Reproject your non-forest canopy shapefile using the “Project (Data 

Management)” tool. “Output Coordinate System” should be “GCS_WGS_1984” or some other 

name that represents the coordinate system WGS84. 



 

 

5. Go to i-Tree Canopy (https://canopy.itreetools.org/); the current version is 7.0. It is 

recommended that you watch the v7.0 tutorial video and read the (short) documentation 

before starting. Once ready, click the blue “Get Started” button on the right side of the page. 

Then click on the “Load Shapefile Boundary” button and navigate to the correct shp and prj files 

in the pop up. If your non-forest shapefile is too large for i-Tree’s uploader (something between 

3.0 MB and 5.5 MB), it’ll just not upload. I don’t know what to do in that case. Maybe split your 

shapefile into multiple smaller ones and use i-Tree on each of them separately? That’ll cause 

analysis issues, though… For the 3.0 MB shapefile, it took nearly a minute to upload (with no 

progress icon or anything to show something was happening).  

https://canopy.itreetools.org/
https://www.itreetools.org/support/resources-overview/video-learning
https://canopy.itreetools.org/references


 

 

 
6. Click “Next”. For the 3 MB non-forest Montgomery County shapefile, it took a few minutes for it 

to move to the next screen after clicking the “Next” button. It seemed like nothing was 

happening but apparently the website was doing something.  

7. For this demo, we are only interested in the presence of trees outside of forests (non-forest 

canopy cover), so click the “Tree/Non-Tree” button on the “Configuration step 2 of 3” page.  

 



 

8. This tutorial isn’t doing anything with the valuation analysis in step 3, but feel free to modify this 

if you want. For the 3 MB shapefile, the page became empty and the URL went back to 

https://canopy.itreetools.org/survey for nearly a minute before the survey page appeared.  

9. Once the survey page appears, you can start analyzing points using the + button above “Save 

your Project” and to the right of the map zoom buttons. Go point by point. i-Tree Canopy 

recommends doing between 500 and 1000 points. How many points you actually need to do 

depends on the size of your community, how much non-forest tree cover there is, the error you 

will accept for your estimates, whether you want to do canopy change detection, and more. 

Make sure to develop standardized rules for classifying points as tree/non-tree, as you’ll repeat 

these methods exactly for future inventory cycles. Rules to consider include what to do if the 

point is on the edge of a tree, where trees end and shadows begin, if there is a minimum canopy 

size for trees, etc. 

 

10. Periodically, click the “Save” button below “Save your Project”. This will open a window in which 

you can type a file name. I recommend including the year of the imagery being used in the 

project name (e.g., “…current_imagery…”). It will then download the project file (no file 

extension) using that name to your download folder. If you close the browser tab before you’ve 

finished your analysis, you can resume the analysis by uploading the project file: Project -> File -

> Open. NOTE: It will not automatically save your progress! 

11. When you’re done analyzing all the points you want to, download the project file one last time 

and then export the project file as a csv: Project -> Export -> CSV. You will use this tabular form 

of the project output for calculating canopy change in Part C. I recommend including the year 

which the data are supposed to represent in the csv name.  

12. Then click on the report button to have a report generated. There doesn’t seem to be any way 

to go back to the survey page once you’ve generated your report without uploading your project 

file again, so make sure to download the project file before so you can pick up where you left off 

if you need to. The most relevant information in the output is the area column, which should 

represent canopy cover outside NLCD forest pixels. To save the report, you can print it as a pdf.  

https://canopy.itreetools.org/survey


 

  



 

Part B: Using i-Tree Canopy to calculate non-forest canopy cover in past years 

This section describes how to calculate non-forest canopy area in one or more past years (called “past 

years” or “historical years”). The initial methods in this section are similar to those in Part A (create a 

non-forest shapefile), then the methods diverge. The next set of steps create the desired amount of 

points in i-Tree Canopy but fill them with default tree/non-tree assignments (dummy points). The final 

set of steps assign those points as tree/non-tree in one or more past years using historical imagery. If 

your GHG inventory is for two historical years (e.g., 2015-2020), you will need to do some steps of this 

part twice. 

 

1. To analyze non-forest canopy, we first need to delineate non-forested areas within the 

inventory area. Theoretically, this could be done in several ways depending on the forest data 

your community has available, but this tutorial will use NLCD because that is universally 

available. First, we need to create a shapefile of non-forest area to upload to i-Tree Canopy. i-

Tree has a limit to how large the uploaded shapefiles can be, so this method may not work for 

large counties with complex forest shapes (which will result in larger non-forest shapefiles). 

According to i-Tree technical support, the upload limit is 2.0 MB, but I have successfully 

uploaded a shapefile that was 3.0 MB (and could not upload a 5.5 MB file), so I don’t know the 

actual limit. To do this, clip the NLCD raster to your inventory area using the Clip (Data 

Management) tool in ArcMap. (This tool clips rasters.) Make sure to select the “Use Input 

Features for Clipping Geometry” box to clip NLCD exactly to your inventory boundary. Use the 

NLCD year that is closest to the year for which you want to calculate non-forest canopy. For 

example, if you want non-forest canopy in 2012, use the 2011 NLCD raster. 

 



 

2. From NLCD clipped to your inventory boundary, create a raster of non-forest NLCD pixels using 

the “Con” tool within your inventory area. (This tool requires the Spatial Analyst license.) The 

forest classes are Deciduous Forest (41), Evergreen Forest (42), Mixed Forest (43), and Woody 

Wetlands (90) (the same as Part A). If using NLCD, put “"Value" NOT IN (41, 42, 43, 90)” in the 

“Expression” input.  

 
 

3. We will upload a single-feature shapefile (i.e. one-row attribute table)—likely with multiple 

parts—to i-Tree Canopy, so we need to convert the non-forest NLCD raster into a single-feature 

shapefile. There are many ways to do this; you can use whatever method is most natural for 

you. One option is to add a new field of any type to the non-forest NLCD land cover raster 

attribute table with any name (here, “dissolve”). This should create a field that has the same 

value for every raster value (e.g. 0). Then, use the “Raster to Polygon” tool to convert the non-

forest raster to a shapefile, with your new field being in the “Field” argument. Leave “Simplify 

polygons” unchecked and check “Create multipart features”. The resulting shapefile should be 

one feature with multiple parts. Also, calculate the area of the non-forest shapefile using the 

“Add Geometry Attributes” tool. I recommend calculating area in hectares because the emission 

and removal factors are in tons of CO2 per hectare. 

  



 

 

4. i-Tree Canopy requires that the shapefile be unprojected in WGS84 coordinate system 

(EPSG:4326). Reproject your non-forest canopy shapefile using the “Project (Data 

Management)” tool. “Output Coordinate System” should be “GSC_WGS_1984”. 



 

 

5. Go to i-Tree Canopy (https://canopy.itreetools.org/); the current version is 7.0. It is 

recommended that you watch the v7.0 tutorial video and read the (short) documentation 

before starting. Once ready, click the blue “Get Started” button on the right side of the page. 

Then click on the “Load Shapefile Boundary” button and navigate to the correct shp and prj files 

in the pop up. If your non-forest shapefile is too large for i-Tree’s uploader (something between 

3.0 MB and 5.5 MB), it’ll just not upload. I don’t know what to do in that case. Maybe split your 

shapefile into multiple smaller ones and use i-Tree on each of them separately? That’ll cause 

analysis issues, though… For the 3.0 MB shapefile, it took nearly a minute to upload (with no 

progress icon or anything to show something was happening).  

https://canopy.itreetools.org/
https://www.itreetools.org/support/resources-overview/video-learning
https://canopy.itreetools.org/references


 

 

 
6. Click “Next”. For the 3 MB non-forest Montgomery County shapefile, it took a few minutes for it 

to move to the next screen after clicking the “Next” button. It seemed like nothing was 

happening but apparently the website was doing something.  

7. For this demo, we are only interested in the presence of trees outside of forests (non-forest 

canopy cover), so click the “Tree/Non-Tree” button on the “Configuration step 2 of 3” page.  

 



 

8. This tutorial isn’t doing anything with the valuation analysis in step 3, but feel free to modify this 

if you want. For the 3 MB shapefile, the page became empty and the URL went back to 

https://canopy.itreetools.org/survey for nearly a minute before the survey page appeared.  

9. Once the survey page appears, you can start analyzing points using the + button above “Save 

your Project” and to the right of the map zoom buttons. Because we’re not actually interested in 

the current non-forest tree cover or comparing current non-forest tree cover to historical tree 

cover, we can basically just click through the points, leaving all of them as the default values. 

What you’re doing is generating the random points that will be used for analysis with historical 

imagery; the tree/non-tree assignments using recent imagery don’t matter at all, so they keep 

the default value. i-Tree Canopy recommends doing between 500 and 1000 points. How many 

points you actually need to do depends on the size of your community, how much non-forest 

tree cover there is, the error that is acceptable for your estimates, and more. NOTE: You are 

welcome to assign tree/non-tree for each point using the recent imagery, but only if you think 

you’ll want recent non-forest canopy later (e.g., new inventory cycle).  

 

10. Periodically, click the “Save” button below “Save your Project”. This will open a window in which 

you can type a file name. I recommend including the fact that the assignments are all default in 

the project name (e.g., “…default_assignments…”). It will then download the project file using 

that name to your download folder. If you need to close the browser tab before you’ve finished 

adding all the points you wanted, you can resume the analysis by uploading the project file: 

Project -> File -> Open. You now have a set of randomly placed points throughout your 

community for which you will assign tree/non-tree for one or more past years using historical 

imagery. The cover class graph in the upper right will look completely imbalanced. NOTE: It will 

not automatically save your progress! 

11. Download Google Earth Pro to your computer: 

https://www.google.com/earth/versions/#download-pro. This might also work with the web 

browser version of Google Earth but I have not tried that.  

12. If your project is currently open in i-Tree, skip this step. If your project is not currently loaded 

into i-Tree Canopy, load it using i-Tree Canopy’s menus: Project -> File -> Open. Browse to your 

project file (which you should have saved regularly, as mentioned above). Opening the project 

https://canopy.itreetools.org/survey
https://www.google.com/earth/versions/#download-pro


 

can take a minute or two. Confirm that this is the set of points you want to use for comparison 

with previous imagery; you must use the same set of points for all time periods. If you’ve 

followed the steps above in Part B, these points will all have the default assignment.  

 

13. Once the project is loaded, export the points as a KMZ file using i-Tree Canopy’s menus: Project -

> Export -> KMZ. Name the file to be exported and it will download to your computer.  

14. Open Google Earth Pro on your computer and load the KMZ file into it: File -> Import -> Navigate 

to the folder with the KMZ. Confirm that the points appear correctly in Google Earth Pro and in 

the Places pane on the left. Expand the list of points in the Places pane. 

 



 

 

15. Start an i-Tree Canopy “change survey” by navigating to Project -> File -> Change Analysis. Load 

your i-Tree Canopy project. This may take a minute or two to load. Immediately save this project 

(Project -> File -> Save) with a new name in order to preserve your original i-Tree Canopy 

project, e.g., Montgomery_County_non_forest_trees_demo__2009_imagery__20201102. This 

project will be the one with the point interpretation at the older time period. That is, you are 

going to be changing the point interpretations in this project file (not in the dummy one with the 

default values you made in the earlier steps).  

16. Place the two applications side-by side: Google Earth Pro on the left and i-Tree Canopy on the 

right. Having two monitors will make the comparison process easier. You will use Google Earth 

Pro to look at the old imagery and i-Tree Canopy (in the recently made historical imagery project 

file) to actually record the historical assignments. In other words, you won’t be changing the 

KMZ file at all, in Google Earth Pro or otherwise; it is simply a place to look at imagery.  

17. Activate the historical imagery in Google Earth Pro (the clock with the counterclockwise arrow 

over it) to select imagery from the earlier year. Make sure to use the same year of imagery for 

all points. Then double-click on the first pin in the Places pane. There might be multiple options 

for imagery in a given year, in which case you can use the images from that year. Beware of 

seasonal (leaf on/off) and daily (shadow) effects on imagery. Make sure to document any rules 

you develop about classifying points for use in future inventories.   



 

 

18. Examine the imagery under the pin for that year and determine if it is a tree or not (or the land 

cover if you are using more categories than tree/non-tree). Double-click on the first row of the 

“View Results” table in i-Tree Canopy. The “View Results” table should be replaced by an 

“Update Point” interface. Change the cover class assignment of the point to that shown in the 

historical imagery and press “Update”. The historical project file you created at the beginning of 

this section has had this point’s dummy assignment replaced now. Make sure to develop 

standardized rules for classifying points as tree/non-tree, as you’ll repeat these methods exactly 

for future inventory cycles. NOTE: Single-clicking on a row in the “View Results” table will show 

the current imagery for that point, if you want to compare the historical (Google Earth Pro) and 

current (i-Tree Canopy) imagery.  

 



 

 

19. Repeat this process for the rest of the points that you assessed using current imagery and which 

are in the KMZ file. As you do this, make sure that you are updating the correct point in i-Tree 

Canopy for each pin in the KMZ (e.g., KMZ pin 6 with i-Tree point 6). The historical imagery may 

of significantly worse quality (resolution) than the recent imagery (see top image below). Also, 

there may be slight shifts between years of historical imagery relative to the point; your 

community will have to decided how to handle that in a consistent manner (see bottom image 

below; thin red line is boundary for non-forest area). Once you have done this for all points, you 

have completed the analysis for one historical year. NOTE: Make sure to save your progress in i-

Tree Canopy often (which will download a new project file to your computer every time you 

save) because it will not automatically save your progress. 

 



 

 

20. When you are done, save the project one last time and export the project file as a csv: Project -> 

Export -> CSV. You will use this tabular form of the project output for calculating canopy change 

in Part C. I recommend including the year which the data are supposed to represent in the csv 

name.  

21. Then click on the report button to have a report generated. There doesn’t seem to be any way 

to go back to the survey page once you’ve generated your report without uploading your project 

file again, so make sure to download the project file before so you can pick up where you left off 

if you need to. The most relevant information in the output is the area column, which should 

represent canopy cover outside NLCD forest pixels in some past year. To save the report, you 

can print it as a pdf.  

 
22. To calculate non-tree canopy for another past year, repeat steps 15-21 in Part B with a different 

year of historical imagery but using the same dummy (all default value) project you made in 



 

Steps 9 and 109. Make sure to name the new historical project file appropriately (step 15) and 

set the correct year of historical imagery (step 17).   



 

Part C: Using i-Tree Canopy to get non-forest canopy cover change between a historical year 

and current year: 

i-Tree Canopy has a documented method for calculating the change in non-forest canopy cover between 

two years (a past year and current year (Part A), or two past years (part B)). To use this part, you must 

already have conducted analyses from two years on the same set of points. The methods here are based 

on the official i-Tree Canopy change methods found here: https://canopy.itreetools.org/index.php/how-

to-use, in the “Change-Analysis Survey using Historical imagery in Google Earth” section but extra detail 

is provided here. The directions inside the spreadsheet tool for calculating changes in canopy cover are 

not entirely clear..  

This part will provide the non-forest activity data for your community forest/tree GHG inventory.  

This tutorial only covers how to use the Excel tool for calculating tree canopy cover change (tree vs. non-

tree), not change between multiple land cover classes. Although this method should work equally well 

for changes in non-forest canopy and changes in all canopy (forest + non-forest), this section continues 

to use non-forest canopy cover.  

If your inventory has multiple non-forest strata for which you have conducted i-Tree analyses (e.g., 

wards in the city, settlement vs. non-settlement area, public land vs. private land), each stratum will 

need its own change analysis. That is, the steps below will need to be repeated for each stratum for 

which you conducted an i-Tree analysis. Likewise, it needs to be repeated for each inventory cycle. So, if 

you did i-Tree analyses in three years (e.g., 2010, 2015, 2020) on the same points, you will need to 

repeat this for the 2010-2015 and 2015-2020 cycles. For an i-Tree inventory with two strata (public vs. 

private land) and two cycles (2010-2015 and 2015-2020), you would do four i-Tree change analyses.   

1. Download the i-Tree Canopy spreadsheet tool for doing land cover change analysis: 

https://www.itreetools.org/documents/618/tree_change_calculator.2020.05.xlsx (also, linked in 

Step 11 of https://canopy.itreetools.org/index.php/how-to-use).  

2. In the comparison tool spreadsheet, on the “Step 1” tab, change the cover class definitions as 

shown below: 1=Non-Tree, 2=Tree, and blank for all other codes. 

https://canopy.itreetools.org/index.php/how-to-use
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3. If you didn’t already download your projects from i-Tree as csvs in Part A, Step 11 and/or Part B, 

Step 20, download them from i-Tree: Project -> Export -> CSV. For each non-forest stratum in 

your inventory, you should have two csvs: assignments of the same points at two points in time 

to tree/non-tree categories.  

4. We will now populate the comparison spreadsheet with the results from the two times (period 

start and period end) to get change. Open the period end csv you downloaded from i-Tree 

Canopy. Copy rows 2 through however many points you analyzed from the recent imagery csv 

into the “Canopy importer” tab of the analysis spreadsheet, starting with cell A9 (not A6, as the 

spreadsheet’s directions say). Columns G and H should auto-populate with the numerical codes 

for the canopy codes assigned at each point. If column H has any #N/As, it means that the value 

in “Cover Class” in that row is not found in the cover class definitions in the “Step 1” tab. Thus, 

make sure that the cover class definitions in Column B of “Step 1” match the classes exported 

from the csvs.   



 

 

5. Copy the yellow cells in Column H of “Canopy Importer” (numerical canopy cover codes from 

recent imager) into Column C, starting at Row 10 (“Cover2”) of “Step 2” tab using “Paste Special- 

Values Only”. Only copy as many rows as points you assessed.  

6. Repeat the above steps with the period start data: open the csv, copy rows 2 and below into 

“Canopy Importer” A9, copy the values “Canopy Importer” column H into E10 and below 

(“Cover1”). 

7. In “Step 2” tab, extend the “ID #” values to the last row of the points, or delete any extra rows of 

data if there are extra. For the “Year1” and “Year2” columns, you can put the year of imagery 

you were trying to use for each (e.g., 2020 and 2009). The comparison table should now be set 

up. If you do not do this, you will not include all of the points you analyzed in i-Tree as part of 

this change analysis. 

 



 

8. Move to “Step 3” tab of the comparison spreadsheet. Choose the level of significance for 

detecting changes in cover; 95% is the default. (We don’t actually use the significance analysis in 

these inventories.) Then click anywhere on the pivot table below (A7 through L19) and click the 

“Refresh” button under Pivot Table Tools -> Analyze in the ribbon menu. This updates the land 

cover conversion matrix. In this case there are only two categories in the matrix (tree/non-tree), 

so it is a 2x2 matrix. The 1s on the diagonal are default and ignored for analysis. 

  

9. Results of the change analysis are in the green tabs: “Summary”, “Matrix”, “Tree Cover”, and 

“Years”. The tabs show the change from tree to non-tree and vice versa (i.e. gross loss and gross 

gain) between the two time periods, along with uncertainty, in various formats. The “Summary” 

tab has the results you need to calculate emissions and removals, but the other tabs may be 

useful for other purposes (not discussed in this guide). The values displayed in the “Summary” 

tab are rounded to the nearest tenth, but the results from i-Tree are actually much more precise 

than that. It is important to retain the full precision of i-Tree’s estimates of the percentages 

from the “Summary” tab, so, when doing the calculations below, copy the “Summary” matrix, 

then use Paste Special->Values in your inventory workbook. The pasted values should be 

displayed to many decimal places in the destination spreadsheet. You’ll round your fluxes to two 

or three significant digits at the end of the inventory, and good practice is to not round 

intermediate results.  

 

There is a difference between how emissions and removals activity data and corresponding 

fluxes are calculated for non-forest canopy vs. for forests. For forests, there are essentially three 



 

components to flux: emissions from forest->non-forest, removals from forest remaining forest, 

and removals from non-forest->forest. For non-forest canopy, there are two components to 

calculating fluxes using i-Tree: emissions from tree->non-tree, and removals from canopy 

gained/maintained. That is, there is only one removals value for non-forest canopy, rather than 

the two values for the forest part of an inventory. The emissions and removals components are 

described below.  

NOTE: The GPC supplement for forests and trees has additional information on calculating 

emissions and removals for trees outside forests (particularly Chapter 8), including sample 

calculations and a downloadable worked example spreadsheet. The worked example 

spreadsheet uses data from i-Tree Canopy for its trees outside forest calsumations. 

a. Emissions: To calculate the gross emissions from loss of non-forest canopy during the 

inventory cycle, multiply the “Loss %” column in the “Tree” row of the “Summary” tab 

(screenshot below, red oval) by the non-forest area in the stratum (calculated using 

“Add Geometry Attributes” in Step 3 of Parts A or B) to get the canopy area lost during 

the inventory cycle. This is your non-forest canopy emissions activity data (gross area of 

non-forest canopy loss during inventory). Then, multiply this canopy lost (activity data) 

by your inventory’s “Trees Outside of Forest” emission factor to get the gross emissions 

from loss of non-forest canopy during the inventory cycle. For US communities 

conducting their inventory with the ICLEI LEARN tool, you can get the emission factor 

from LEARN (bottom image). Make sure to do any necessary unit conversions to turn 

the emission factor into tonnes CO2. For example, if the emission factor is in tonnes C 

(as in the ICLEI LEARN tool), multiply it by 44/12. Gross emissions can then be divided by 

the number of years in the inventory to get annual gross emissions from loss of trees 

outside forests. 

EXAMPLE using the i-Tree screenshot below: Gross canopy loss was 3.6% over the 

inventory cycle of 2009-2020 (Loss %” column in the “Tree” row of the “Summary” tab, 

screenshot below). Assume the non-forest area in this inventory stratum was 1,000 ha. 

Assume an emission factor for trees outside forests of 103 t C/ha, as shown in the final 

screenshot (LEARN tool). 

Activity data: 1,000 ha * 0.036 “Loss %” = 36 ha canopy lost between 2009 and 2020 

Emission factor: 103 t C/ha * 44/12 ratio CO2 to C = 377.67 t CO2/ha  

Gross emissions: 36 ha * 377.67 t CO2/ha = 13,596 t CO2 emitted between 2009 and 

2020 

Annual emissions: 13,596 t CO2 / (2020-2009 years) = 1,236 t CO2/yr 

b. Removals: Removals occur both in trees that survive the entire inventory cycle and in 

trees gained during the inventory. For simplicity, Appendix J of the US Community 

Protocol and the GPC Supplemental Guidance on Forests and Trees combine these two 

areas into a single activity data value and use the same removal factor for them, so this 
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http://www.icleiusa.org/learn/
http://www.icleiusa.org/learn/
http://www.icleiusa.org/learn/
http://www.icleiusa.org/learn/
https://us-protocol.pubpub.org/pub/v732gbdy/release/1
https://ghgprotocol.org/gpc-supplemental-guidance-forests-and-trees


 

guide takes the same approach. The percent of the non-forest area in which removals 

occur is the average of the starting and ending tree area found in the “Tree” row of the 

“Summary” tab (screenshot below, blue ovals). Multiply this percent by the non-forest 

area (calculated using “Add Geometry Attributes” in Step 3 of Parts A or B) to get the 

average area with non-forest canopy during the inventory cycle. This is your non-forest 

canopy removals activity data (gross area of non-forest tree cover gained or maintained 

per year). Then, multiply this canopy area gained or maintained by your inventory’s 

“Trees Outside of Forests” removal factor to get the annual gross removals from non-

forest canopy gained and maintained during the inventory cycle. For US communities 

conducting their inventory with the ICLEI LEARN tool, you can get the removal factor 

from LEARN (bottom image). Make sure to do any necessary unit conversions to get the 

removal factor into tonnes CO2. For example, if the removal factor is in tonnes C (as in 

the ICLEI LEARN tool), multiply it by 44/12. Annual gross removals can then be 

multiplied by the number of years in the inventory to get total gross removals from 

trees outside forests. 

EXAMPLE using the i-Tree screenshot below: Canopy was at 25.4% in 2009 and 27.9% in 

2020 (“%” columns in “Tree” row of “Summary” tab). Assume the non-forest area in this 

inventory stratum was 1,000 ha. Assume a removal factor for trees outside forests of -

3.5 t C/ha/yr, as shown in the final screenshot (LEARN tool). 

Activity data: (27.9% + 25.4%)/2 = 26.65% canopy coverage between 2009 and 2020 

26.65% * 1,000 ha = 266.5 ha canopy gained or maintained between 2009 and 2020 

Removal factor: -3.5 t C/ha/yr * 44/12 CO2:C = -12.83 t CO2/ha/yr  

Gross removals: 266.5 ha * -12.83 t CO2/ha/yr = -3,420 t CO2/yr sequestered annually 

Total gross removals emissions: -3,420 t CO2/yr * (2020-2009 years) = -37,620 t CO2 

sequestered over entire inventory  

 You now have gross emissions and removals for non-forest canopy during an inventory cycle. 

Repeat these directions for any other inventory cycles or non-forest strata in your inventory. 
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